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1. INLEIDING

Als organisatie kunt u aansluiten op de SURFfederatie met het protocol Active Directory
Federation Services 2.0 (AD FS 2.0) van Microsoft. U kunt aansluiten op twee manieren:

* als Identity Provider (IDP), in AD FS-terminologie ‘Account Partner’ (AP) genoemd.
Bent u IDP, dan is de Active Directory van uw organisatie ontsloten naar de
SURFfederatie. Hierdoor kunnen gebruikers in uw Active Directory zich
authenticeren voor diensten binnen de SURFfederatie.

* als Service Provider (SP), in AD FS-terminologie ‘Resource Partner’ (RP) genoemd.
In deze rol kunt u als organisatie ook diensten aanbieden via de SURFfederatie.

In deze handleiding leest u hoe u uw organisatie aansluit in de rol van Identity Provider,
de rol die voor de meeste instellingen van toepassing zal zijn.

De procedure voor het aansluiten als IDP bestaat uit de volgende onderdelen:

1. Een AD FS 2.0-serversysteem inrichten, o.a. Windows Server 2008 configureren en
AD FS 2.0 installeren (hoofdstuk 2)

2. De AD FS 2.0-server configureren voor aansluiting als Identity Provider voor de
SURFfederatie (hoofdstuk 3)

3. Een AD FS 2.0 proxy inrichten (hoofdstuk 4)

4. Attributen vrijgeven aan de SURFfederatie (hoofdstuk 5)

1.1 Meer informatie over AD FS 2.0

AD FS 2.0 (codenaam Geneva Server) is de opvolger van AD FS v1 zoals oorspronkelijk
beschikbaar op Windows Server 2003 R2 en Windows Server 2008. De belangrijkste
wijziging ten opzichte van AD FS v1 is de ondersteuning van het SAML 2.0 protocol. Meer
informatie over AD FS 2.0 is hier te vinden:

http://www.microsoft.com/windowsserver2008/en/us/ad-fs-2-overview.aspx

Deze handleiding is gebaseerd op de release van AD FS 2.0 (5 mei 2010). Meer
informatie over de installatie van AD FS 2.0 is hier te vinden:

http://technet.microsoft.com/en-us/library/adfs2(WS.10).aspx

Voor een step-by-step guide van Microsoft, wellicht handig als naslagwerk naast deze
handleiding, zie:

http://technet.microsoft.com/en-us/library/ff631096(WS.10).aspx

1.2 Waarom server en proxy?

Naast het inrichten van een AD FS 2.0-server is het noodzakelijk om 'voor' de AD FS-
server, buiten het Windows-domein, een AD FS-proxy in te richten die het verkeer van
buitenaf doorstuurt naar de AD FS-server. Dit houdt in dat er 2 verschillende Windows
Server 2008 machines geconfigureerd worden in deze setup.
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Dit heeft de volgende reden: de AD FS-server moet in het Windows-domein worden
opgenomen en daarom liever niet direct bereikbaar zijn van buitenaf. Door een AD FS-
proxy in te richten en deze voor de AD FS-server te plaatsen, buiten het Windows-
domein, is de AD FS-server minder kwetsbaar voor aanvallen van buitenaf.

Bijkomend voordeel is dat een proxy kan worden geconfigureerd om een loginpagina met
de look-and-feel van de instelling te tonen aan de gebruiker, in plaats van de standaard
popup-prompt die de AD FS-server laat zien. Dit verbetert de herkenbaarheid van de
login voor de eindgebruiker en biedt de mogelijkheid extra informatie aan de gebruiker te
tonen. Daarnaast kan phishing beter worden voorkomen door het door het toepassen van
een geldig SSL-servercertificaat.

1.3 Auteurs

Deze handleiding is tot stand gekomen door bijdragen van Paul Lemmers (DevCon), Jan
Michielsen (bureau Hendrikx Van der Spek), Remco Poortinga (SURFnet bv) en Hans
Zandbelt (SURFnet bv).
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2. AD FS 2.0-SERVER INRICHTEN

2.1 Inleiding

Voordat u de specifieke instellingen voor de SURFfederatie kunt invoeren, moet u een
basisinstallatie op de AD FS 2.0-server uitvoeren. Dat gaat in de volgende stappen:

1. Windows Server 2008 installeren en configureren (paragraaf 2.1)
2. De AD FS 2.0-software installeren (paragraaf 2.2)

3. Basisinstellingen van AD FS 2.0 configureren (paragraaf 2.3)

2.2 Windows Server 2008 installeren en configureren

Om een AD FS 2.0-server te kunnen inrichten, moet u eerst Windows Server 2008
installeren en configureren:

* Installeer de juiste versie van het besturingssysteem op de server: Windows
Server 2008 SP2 of Windows Server 2008 R2 (standaard of enterprise).

* Stel de tijd op de server correct in zorg dat deze wordt gesynchroniseerd met een
time server.

* Neem de server op in het domein van de Active Directory waaruit de accounts
voor de federatie komen.

* Installeer Internet Information Services (IIS) en zorg dat deze een geldig SSL-
servercertificaat heeft. U kunt servercertificaten (onder meer) verkrijgen via de
SURFcertificaten-dienst van SURFnet:
http://www.surfnet.nl/nl/diensten/authenticatie/Pages/certificaten.aspx

2.3 AD FS 2.0-software installeren

1. Download AD FS 2.0 Server via http://go.microsoft.com/fwlink/?linkid=151338 voor uw
platform (Windows Server 2008 SP2 of 2008 R2, 32 of 64 bits) en start de
executable.

2. Doorloop het begin van de procedure en accepteer de licentieovereenkomst.
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'%iilhctive Directory Federation Services 2.0 Setup Wizard

Server Role ﬁﬁ]

You can configure this computer in either the federation server role or the federation server proxy role. Select
one of the following roles for this computer.

% Federation server

Afederation server is an authentication and trust management provider that issues security tokens to
enable access to claims-based applications in your organization or in federated partner organizations.

" Federation server proxy
A federation server proxy redirects requests from Intemet clients to federation servers that are behind a

firewall on your corporate network. It also forwards security tokens issued by federation servers to
clients.

< Previous | Next > Cancel I

3. Selecteer Federation server en klik op Next.

De eigenlijke installatie begint nu.

4. Volg de stappen in de wizard.

Nadat de software is geinstalleerd, verschijnt het volgende venster:

'%;lActive Directory Federation Services 2.0 Setup Wizard

Completed the AD FS 2.0 Setup Wizard W

You have successfully completed the AD FS 2.0 Setup Wizard. You must restart this computer before you can
finish configuring this computer for the federation server role.

After you restart the computer, you can finish configuring this computer by starting the AD FS 2.0 Management
snap-in located in the Administrative Tools menu, and then clicking the link for the AD FS 2.0 Federation Server
Configuration Wizard in the snap-n.

V' Restart now

To close this wizard, click Finish.

5. Zorg dat Restart now aangevinkt is en klik op Finish.

De server start opnieuw op. Hiermee is de basisinstallatie van de AD FS 2.0-software
afgerond.
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2.4 Basisinstellingen AD FS 2.0 configureren

1. Kies Start > All Programs > Administrative Tools > AD FS 2.0 Management om
de AD FS 2.0-configuratieapplicatie te starten.

"% AD FS 2.0 =] B3

il Fle Acon View Window Help | =18 ]

_m_i _ Actions
ADFS 2.0 -

OverVieW AD FS 2.0 Federation Ser...

AD FS 2.0 provides single-sign-on (SSO) access for client computers. View 4

New Window from Here

0 Configure This Federation Server B reb

The AD FS 2.0 Federation Server Configuration Wizard must first be completed successfully before
you can use this snap-in to manage your Federation Service.

=

= ADFS 20 F ion Server C ion Wizard

0 Learn About:

Configuring Claims Provider or Relying Party Trusts
Adding Federation Servers to a Farm and Setting Up Load-Balancing

C ing F ion Server Proxies

Troubleshooting AD FS 2.0

2. Klik op AD FS 2.0 Federation Server Configuration Wizard.

'ﬁIAD FS 2.0 Federation Server Configuration Wizard B3
Welcome
Steps

Welcome to the AD FS 2.0 Federation Server Configuration Wizard
@ Welcome
This wizard helps you configure Active Directory Federation Services (AD FS) 2.0 software on this

@ Select Deployment Type computer, which sets up the computer as a federation server. An instance of AD FSis refemed to as a

@ Federation Service Name Federation Service.
@ Summary () Create a new Federation Service

R Select this option to set up either a stand-alone federation server or the first server in a federation
@ Reads server fam.

{0 Add a federation server to an existing Federation Service
Select this option to join this computer to an existing federation server fam.

Previous | Next > Cancel Help
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3. Selecteer Create a new Federation Service en klik op Next.

%{AD FS 2.0 Federation Server Configuration Wizard | X]

Select Stand-Alone or Farm Deployment

Steps You can create either a stand-alone federation server for evaluation purposes or a small production

@ Welcome environment, or you can create a federation server in a new fam for load balancing and high availability.

@ Select Deployment Type Select one of the following options. Either of these options will use the Windows Intemal Database to store
configuration data.

@ Federation Service Name

® Summary O New federation server farm

o Fesis This option will create a new Federation Service with settings for high availability and load balancing.

This computer will be the primary federation server in the fam. Later, you can scale out this fam by
adding more federation servers.

To create a federation server fam, you must run this wizard while you are logged on with an account
that has sufficient pemissions in Active Directory to create a container object for sharing certificates)
and to set an SPN ffor the service account), such as an account that is a member of the Domain
Admins group.

() Stand-alone federation server

This option will create a new Federation Service on this computer. This option is recommended for
evaluation purposes or a small production environment. if you select this option, you will not be able
to add more servers to create a fam.

@ You can use SQL Server with AD FS 2.0to take advantage of the full feature set and achieve

maximum scalability. To set up AD FS to use SQL Server, use the command-ine version of this
wizard. For more information, click Help

< Previous | Next > Cancel | Help |

4. Selecteer Stand-alone federation server en klik op Next.

")’;IAD FS 2.0 Federation Server Configuration Wizard | X]

Specify the Federation Service Name

Steps This wizard determines the Federation Service name from the Subject field of the SSL certificate for the

@ Welcome Default Web Site. If the wizard cannot determine the Federation Service name from the SSL settings, you
must select a certificate.

@ Select Deployment Type

Select the certificate and/or port, and then click Next.

@ Federation Service Name

@ Summary SSL certificate: Port:

geneval.showcase.surinet.n 'i 843 v
@ Results = | View...

Federation Service name:

geneva2.showcase surfnet.nl -

What kind of cettificate do | need?

< Previous | Next > Cancel Help
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5. In het veld 'Federation Service name' is de hostnaam van uw server al ingevuld. Laat
deze ongewijzigd en klik op Next.

'*leD FS 2.0 Federation Server Configuration Wizard E3
Ready to Apply Settings

Steps The following settings will be configured for AD FS 2.0:
@ Welcome
» Stop AD FS server.
@ Select Deployment Type »  Windows Intemal Database service will be started and set to automatic startup.
B Pt e N » Signing and token-encryption certificates will be generated and set to automatic roll over.
. a5 T i » Selected SSL certificate will be used for securing service communication.
& Summary » Network Service account will be given access to the database, to the certificate private keys and
endpoints, and the service will run under this account.
@ Results » Default set of endpoints will be enabled.
»  Browser sign-in web site will be deployed to the /adfs/Is’ vittual directory under the Default Web Site in
IIS.
» Federation Service name is geneva2 showcase surfnet.nl
* Start AD FS server.

To begin configuring this computer with these settings, click Next.

< Previous | Next > Cancel Help

6. Klik op Next om de ingestelde settings toe te passen.

'*leD FS 2.0 Federation Server Configuration Wizard | X}

Configuration Results

Steps The following settings are being configured
@ Welcome
Component Status
@ Select Deployment Type
¢)'| Stop the AD FS 2.0 Windows Service Corfiguration finished
@ Federation Service Name
¢))| Install Windows Intemal Database Configuration finished
@ Summary
)| Start the Windows Intemal Database service Conrfiguration finished
2 Result
S ¢))|Create AD FS configuration database Conrfiguration finished
)| Configure service settings Configuration finished
)| Deploy browser sign+in Web site Configuration finished
¢))| Start the AD FS 2.0 Windows Service Configuration finished
) | Create default claim set Configuration finished
') | Create default Active Directory claim acceptance rules | Configuration finished

You have successfully completed the AD FS 2.0 Federation Server Configuration Wizard.

To close this wizard, click Close.

7. Klik op Close als het configuratieproces is afgerond.

Hiermee is ook de basisinstallatie van de AD FS 2.0-server afgerond.
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ey

3. AD FS 2.0-SERVER CONFIGUREREN ALS

IDENTITY PROVIDER

3.1 Inleiding

Om uw gebruikers met hun instellingsaccount toegang te kunnen geven tot diensten van
de SURFfederatie, moet u uw AD FS 2.0-server configureren als Identity Provider.

3.2 Basisconfiguratie

1. Kies Start > All Programs > Administrative Tools > AD FS 2.0 Management om

de AD FS 2.0-configuratieapplicatie te starten.

L - >
il Fle Acon View Window Help | =811
= | iE
, ] [~
@ ] Service | aprs20 -
@ || Trust Relationships .
Overvlew Add Relying Party Trust...
AD FS 2.0 provides single-sign-on (S50) access for client computers. Add Claims Provider Trus...

0 Required Configuration Incomplete

Before you can use AD FS 2.0to manage SSO access for users and services, you must complete the
following task

=

%7 Required: Add a trusted relying party

Q Learn About:

Configuring Claims Provider or Relying Party Trusts
Adding Federation Servers to a Farm and Setting Up Load-Balancing

C ing F ion Server Proxies

Troubleshooting AD FS 2.0

=

Add Attribute Store...

Edit Federation Service P...
Edit Published Claims

Revoke All Proxies

Provide Feedback

View >

New Window from Here

3 Refresh

Help

10
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2. Klik op Required: Add a trusted relying party.

"ﬁlMd Relying Party Trust Wizard

Welcome

Steps
@ Welcome
@ Select Data Source

@ Choose Issuance
Authorization Rules

@ Readyto Add Trust
@ Finish

Welcome to the Add Relying Party Trust Wizard

This wizard will help you add a new relying party trust to the AD FS configuration database. Relying parties
consume claims in security tokens that are issued by this Federation Service to make authentication and
authorization decisions.

The relying party trust that this wizard creates defines how this Federation Service recognizes the relying
party and issues claims to it. You can define issuance transform rules for issuing claims to the relying party
after you complete the wizard.

=yioU | Start I Cancel Help

3.

Klik op Start.

11
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"T;IMd Relying Party Trust Wizard  X|

Select Data Source

Steps Select an option that this wizard will use to obtain data about this relying party:
@ Welcome
' Import data about the relying party published online or on a local network
Use this option to import the necessary data and certfficates from a relying party organization that

@ Choose Issuance publishes its federation metadata online or on a local network.
Authorization Rules

@ Readyto Add Trust
@ Finish

@ Select Data Source

Federation metadata address (host name or URL):
Il-lttps:;"./wa)'f surfnet nl federate/metadata/saml20/self|

Example: fs.contoso.com or https://www.contoso.com/app

" Import data about the relying party from a file
Use this option to import the necessary data and certificates from a relying party organization that has
exported its federation metadata to a file. Ensure that this file is from a trusted source. This wizard will
not validate the source of the file.
Federation metadata file location:

" Enter data about the relying party manually

Use this option to manually input the necessary data about this relying party organization.

< Previous | Next > Cancel | Help |

4. Vul in het veld 'Federation metadata address (host name or URL)' de volgende URL in:
https://wayf.surfnet.nl/federate/metadata/saml20/self en klik op Next.

"% Add Relying Party Trust Wizard B3
Specify Display Name

Steps Type the display name and any optional notes for this relying party.

@ Welcome

@ Select Data Source e
SURFfederatie|
@ Specify Display Name
@ Choose Issuance Notes:
Authorization Rules d
@ Readyto Add Trust
@ Finish

< Previous | Next > Cancel | Help |

5. Vervang in het veld 'Display name' de default hostnaam (wayf.surfnet.nl) door de
naam 'SURFfederatie' en klik op Next.

12
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"3 Add Relying Party Trust Wizard B3

Choose Issuance Authorization Rules

Steps Issuance authorization rules determine whether a user is permitted to receive claims for the relying party.

@ Welcome Choose one of the following options for the initial behavior of this relying party’s issuance authorization
rules.

@ Select Data Source

@ Specify Display Name ¢ Pemit all users to access this relying party

S R R The issuance authorization rules will be configured to pemit all users to access this relying party. The

it eration Filos relying party service or application may still deny the user access.
@ Readyto Add Trust " Deny all users access to this relying party
@ Finish The issuance authorization rules will be configured to deny all users access to this relying party. You must

later add issuance authorization rules to enable any users to access this relying party.

You can change the issuance authorization rules for this relying party trust by selecting the relying party
trust and clicking Edit Claim Rules in the Actions pane.

< Previous | Next > Cancel I Help |

6. Selecteer Permit all users to access this relying party en klik op Next.

"3 Add Relying Party Trust Wizard B3
Ready to Add Trust

Steps The relying party trust has been configured. Review the following settings, and then click Next to add the

@ Welcome relying party trust to the AD FS configuration database.

@ Select Data Source

@ Specify Display Name Monitoring I Identifiers | Encryption | Signature | Accepted Claims | Organization | Endpoints | N_4 [»

@ Choose lssuance Specify the monitoring settings for this relying party trust.

Authorization Rules

Relyi ’s federati etadata URL:
@ Readyto Add Trust g Al bt

Ihﬂps -/ /wayf surfnet nl federate/metadata/saml20/seff

@ Finish
IV Wonitor relying party

This relying party’s federation metadata data was last checked on:
5/7/2010

This relying party was last updated from federation metadata on:
5/7/2010

< Previous | Next > Cancel Help
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7. Klik in dit overzichtsvenster op Next.

"% Add Relying Party Trust Wizard B3
Finish

Steps The relying party trust was successfully added to the AD FS configuration database.
@ Welcome

You can modify this relying party trust by using the Properties dialog box in the AD FS 2.0 Management
@ Select Data Source snapn.

@ Specify Display Name
™ Open the Edit Claim Rules dialog for this relying party trust when the wizard closes
@ Choose Issuance
Authorization Rules

@ Readyto Add Trust
@ Finish

Close

Deselecteer Open the Edit Claim Rules dialog... Met de 'Claims Rules dialog'
worden de attributen geconfigureerd. Dit doet u later in het configuratieproces (zie
hoofdstuk 5).

Klik op Close om deze configuratie af te ronden.

14
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3.3 SHA1l-algoritme inschakelen

In AD FS 2.0 worden handtekeningen standaard gezet met behulp van het SHA256-
algoritme. Dit algoritme werkt niet goed samen met de SURFfederatie. Voor een goede
werking moet dit vervangen worden door het SHA1-algoritme.

1. Kies in de linkerkolom van het overzichtsvenster Trust Relationships > Relying
Party Trusts.

L
i File Acon View Window Help ST
e 20 @
205520 Actions
B e [Dspytiame  [Ewbed [Gente | |RevinoParyTusts
| Claims Provider Trusts SURFfederatie Yes wayf surfnet.nl Add Relying Party Trust...
e N

New Window from Here

[ Refresh

E Help

SURFfederatie -
Update from Federation ...
Edit Claim Rules...
Disable
Properties

A Delete

H vep

2. Dubbelklik in de middelste kolom op SURFfederatie.

SURFfederatie Properties | X
Monitoring I Identifiers | Encryption I Signature |

Accepted Claims | Organization | Endpoints | Notes ~ Advanced

Specify the secure hash algorithm to use for this relying party trust.

Secure hash algorithm: SHA-1 =

OK I Cancel Apply Help

15
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3. Selecteer het tabblad Advanced en kies in het veld 'Secure hash algorithm' de
waarde SHA-1.

4. Klik op OK om de configuratie voor de SURFfederatie af te ronden.

3.4 Testen

Het is aan te bevelen om ook een aansluiting om de SURFfederatie testomgeving te
configureren om uw installatie te kunnen testen in het geval van wijzigingen.

1. Kies links in het overzichtsvenster Trust Relationships > Relying Party Trusts.

e nrnn=ng----'’?’ ¥} } ¥Y\;§¥§4"''y  ;y¥y$\\)}t!}  \ (¥ I
l?@iFieiA:ﬁon View Window Help 18]
Y Yl 16
o Achins
t ::relz\s/;c;elabonshlps Display Name Enabled Relying Party Trusts -
| Claims Provider Trusts SURFfederatie Yes wayf sufnet.nl Ak Richiin Pty Tk
: Eiﬁ‘ﬁt:zﬁ;;ms View »
New Window from Here
[ Refresh
H tep

\Add a new relying party trust to the configuration database

2. Klik in de rechterkolom onder 'Actions' op Add Relying Party Trust....
3. Doorloop nu opnieuw de stappen uit paragraaf 3.2 en 3.3, met deze verschillen:

- in paragraaf 3.2, stap 4 vult u de URL https://wayf-
test.surfnet.nl/federate/metadata/saml20/self in.

- in paragraaf 3.2, stap 5 vult u de 'Display name' de waarde 'SURFfederatie
(TEST)'" in.

16
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ey

Het overzichtsvenster bevat nu twee relying party entries, en ziet er als volgt uit:

Ik
\i Fle Acton View Window Help | =181
e 2w Em
| ADFS 2.0 Relying Party Trusts Actions
® (] Service - = -
= [ Trust Relationships Displa Name? Enabled Relying Party T -
| Claims Provider Trusts SURFfederatie Yes wayf surfnet.nl Add Relying Party Trust...
| Relying Party Trusts SURFederatie (TEST) Yes wayfiest.surfnet.nl - R
| Attribute Stores

New Window from Here
|G Refresh

ﬂ Help

\Add a new relying party trust to the configuration database

4. Controleer of de SAML 2.0 metadata informatie van uw server beschikbaar is op de
volgende URL:

https://<hostnaam>/FederationMetadata/2007-06/FederationMetadata.xml (vul zelf
de juiste hostnaam in).

17
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4. AD FS 2.0-PROXY INRICHTEN

4.1 Inleiding

De AD FS-proxy hoeft niet op een aparte machine te worden geinstalleerd, maar kan op
een bestaande machine komen te staan die ook al voor andere doeleinden in gebruik is.

De installatie van een AD FS 2.0-proxy gaat in de volgende stappen:
1. Windows Server 2008 installeren en configureren (paragraaf 4.1)
2. AD FS 2.0-software installeren (paragraaf 4.2)

3. De instellingen van de AD FS 2.0-proxy configureren (paragraaf 4.3)

4.2 Windows Server 2008 installeren en configureren

Om een AD FS 2.0-proxy te kunnen inrichten, moet u eerst Windows Server 2008
installeren en configureren:

* Installeer de juiste versie van het besturingssysteem op de server: Windows
Server 2008 SP2 of Windows Server 2008 R2 (standaard of enterprise).

* Stel de tijd op de server correct in zorg dat deze wordt gesynchroniseerd met een
time server.

» Zorg ervoor dat de server niet opgenomen is in het domein van de Active
Directory waaruit de accounts voor de federatie komen.

* Installeer Internet Information Services (IIS) en zorg dat deze een geldig SSL-
servercertificaat heeft. U kunt servercertificaten (onder meer) verkrijgen via de
SURFcertificaten-dienst van SURFnet:
http://www.surfnet.nl/nl/diensten/authenticatie/Pages/certificaten.aspx

18
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4.3 AD FS 2.0-software installeren
Zie paragraaf 2.3 voor het installeren van de AD FS 2.0-software, met dit verschil:

kies bij stap 3 voor Federation server.

",a'l Active Directory Federation Services 2.0 Setup Wizard [ ]

Server Role %]

You can configure this computer in either the federation server role or the federation server proxy role. Select
one of the following roles for this computer.

" Federation server

Afederation serveris an authentication and trust management provider that issues security tokens to
enable access to claims-based applications in your organization or in federated partner organizations.

% Federation server proxy
A federation server proxy redirects requests from Intemet clients to federation servers that are behind a

firewall on your corporate network. It also forwards security tokens issued by federation servers to
clients.

< Previous I Next > Cancel

4.4 AD FS 2.0 Proxy Configuratie

1. Kies Start > Programs > Administrative Tools > AD FS 2.0 Federation Server
Proxy Configuration Wizard om de AD FS 2.0-proxy configuratieapplicatie te

starten.
Welcome
Steps
e Welcome to the AD FS 2.0 Federation Server Proxy Configuration
@ ‘eicome

Wizard
@ Specify Federation Service

Name This wizard helps you configure Active Directory Federation Services (AD FS) 2.0 software on this
) computer, which sets up the computer as a federation server proxy. A federation server proxy redirects
@ Ready to Apply Settings requests from Intemet clients to federation servers that are behind a firewall on your corporate network.
@ Configuration Results Before you begin
@ Afederation server and a federation server proxy cannot be configured on the same computer.

@ You will need the name of the Federation Service that has already been deployed in your
organization.

To continue, click Next.

eviol | Next > Cancel Help
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2. Klik op Next.

"EIAD FS 2.0 Federation Server Proxy Configuration Wizard B3

Specify Federation Service Name

Steps Specify the name of the Federation Service to which this federation server proxy will redirect client
@ Welcome requests.
@ Specify Federation Service Federation Service name:

Name

|geneva‘I[showcase.suvfnet.nl
@ Ready to Apply Settings

@ Configuration Results

Example: fs.contoso.com

[ Usean HTTP proxy server when sending requests to this Federation Service

HTTP proxy server address:

Example: http://proxy.contoso.com:3000/

Test Connection

< Previous | Next > Cancel Help |

Vul in het veld 'Federation Service name' de naam in van uw AD FS 2.0-server die u
in paragraaf 2.4 hebt gekozen. Normaal gesproken is dit de hostnaam van de AD FS
2.0-server.

4. Klik op Next.

AD FS 2.0 Federation Server Proxy Configuration Wizard | X

‘0‘ The specified Federation Service was contacted successfully.

De popup geeft aan dat er een succesvolle verbinding van de proxy naar de server
gelegd kon worden.

5. Klik op OK.

Windows Security

Enter Credentials

Enter the credentials that will be used to establish a trust between this
federation server proxy and the Federation Service.

— |admini5trator |
=

Domain: SHOWCASE
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6. Voer gebruikersnaam en wachtwoord in van het adminstrator-account van de AD FS
2.0-server en klik op OK.

"ELAD FS 2.0 Federation Server Proxy Configuration Wizard | X}

Ready to Apply Settings

Steps The following settings will be configured for this federation server proxy:
@ Welcome

s Stop the AD FS 2.0 Windows service
@ Specify Federation Service

Name

Establish trust with the Federation Service

@ Readyto Apply Settings

Configure endpoints
@ Configuration Results

Deploy browser sign+n Web site

Start the AD FS 2.0 Windows service

To begin configuring this computer with these settings, click Next.

< Previous | Next > Cancel Help
7. Klik op Next.
"ELAD FS 2.0 Federation Server Proxy Configuration Wizard B3
Configuration Results
Steps The following settings are being configured.
@ Welcome T
C nt Stat

@ Specify Federation Service ! apene i

Name ¢) | Stop the AD FS 2.0 Windows service Configuration finished
@ Ready to Apply Settings ) | Establish trust with the Federation Service | Configuration finished
@ Configuration Results ¢) | Configure endpoints Configuration finished

‘) | Deploy browser signin Web site Configuration finished

) | Start the AD FS 2.0 Windows service Configuration finished

You have successfully completed the AD FS 2.0 Federation Server Proxy Configuration Wizard.

To close this wizard, click Close.

8. Klik op Close als de installatie voltooid is.
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4.5 DNS configureren

Als de server en de proxy zijn ingericht, moet u de DNS-configuratie nog aanpassen.
Interne verzoeken (van binnen het Windows-domein) moeten namelijk direct naar de
server worden geleid, externe verzoeken moeten via de proxy lopen.

Registreer de IP-adressen van de AD FS 2.0-server en —-proxy in het DNS als volgt:

* het adres ‘adfs.mycampus.nl’ moet voor verzoeken vanaf uw eigen domein resolven
naar de AD FS 2.0-server.

* het adres ‘adfs.mycampus.nl’ moet voor verzoeken vanaf externe domeinen resolven
naar de AD FS 2.0-proxy.

Het testen van de proxy kan verlopen door op een client machine tijdelijk de HOSTS-file
aan te passen naar de nieuwe situatie.

4.6 Testen

1. Stuur een e-mail naar SURFfederatie Beheer (federatie-beheer@surfnet.nl), waarin u
aangeeft dat u op de productie- en testomgeving van de SURFfederatie wilt aansluiten
met uw AD FS 2.0-server. Geef daarbij de URL van uw AD FS 2.0-server door
(adfs.mycampus.nl).

2. Wacht tot uw gegevens geconfigureerd zijn (u krijgt hiervan bericht) en test daarna
via: https://wayf-test.surfnet.nl/attributes.

4.7 Login pagina aanpassen

De standaard login pagina op de ADFS proxy kan nu worden aangepast naar de look-and-
feel van uw instelling, door de file:

C:\Program Files\Active Directory Federation Services
2.0\WSFederationPassive.Web\FormsSignIn.aspx

te wijzigen. Bij voorkeur dient hier tekst te worden opgenomen over:

* de manier waarop gebruikers moeten inloggen, bijv. in welk formaat de user
identifier moet worden ingevoerd (bijv. “student nummers” of "NetID")

* een waarschuwing dat (bijv. bij gebruik op publieke terminals), uitloggen alleen
voor gegarandeerd kan worden door de browser af te sluiten

* dat bij het inloggen moet worden gelet op een geldige HTTPS URL op de juiste
server
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5. ATTRIBUTEN VRIJGEVEN

5.1 Inleiding

Attributen zijn gebruikerkenmerken die de AD FS 2.0-server na een geslaagde
authenticatie van een gebruiker kan toevoegen aan informatie die aan de SURFfederatie
wordt doorgegeven. Voorbeelden van attributen zijn het e-mailadres van de gebruiker of
de naam van een groep waar de gebruiker lid van is.

De set van gestandaardiseerde attributen die binnen de SURFfederatie kunnen worden
gebruikt, vindt u hier:

http://www.surffederatie.nl/attributenschema

Voordat de SURFfederatie attributen kan gebruiken in het authenticatieproces, moet u ze
vrijgeven aan de SURFfederatie. In dit hoofdstuk worden vier attributen als voorbeeld
vrijgegeven:

*  Name ID (loginnaam)

° urn:mace:dir:attribute-def:uid (loginnaam; kan verschillen van waarde bij User ID)
e urn:mace:dir:attribute-def:mail (e-mailadres)

° urn:mace:dir:attribute-def:displayName (weergavenaam)

Deze fungeren slechts als voorbeeld; overleg met SURFnet over de specifieke attributen
die uw organisatie nodig heeft voor het benaderen van diensten in de SURFfederatie. Een
overzicht daarvan vindt u hier:

http://www.surffederatie.nl/attributen

Het vrijgeven van attributen bestaat uit twee stappen
1. Attributen definiéren (paragraaf 5.2)
2. Attributen toewijzen aan de SURFfederatie (paragraaf 5.3)

3. Testen (paragraaf 5.4)

5.2 Attributen definiéren

1. Kies op de AD FS 2.0-server Start > All programs > Administrative Tools > AD
FS 2.0 Management om de AD FS 2.0 configuratieapplicatie te starten.

2. Selecteer Service > Claims Descriptions in de linker kolom van het
overzichtsvenster.
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s
i Fle Acton View Window Help ‘ =8 x|
&= fmldEE
| ADFS 2.0 Claim Descriptions Actions
B Sej”g;*dmm Name Ciaim Type Published ... Claim Descriptions =
| Certificates E-Mail Address http://schemas xmlsoap .org/ws/2005/05/identit Yes Yes Add Claim Description...
] Given Name http://schemas xmisoap.org/ws/2005/05/identit... Yes Yes
= [ Trust Relationships Name http://schemas xmlsoap .org/ws/2005/05/identit... Yes Yes View 4
| Claims Provider Trusts UPN http://schemas xmisoap.org/ws/2005/05/identit... Yes Yes New Window from Here
_| Relying Party Trusts Common Name http://schemas xmlsoap .org/claims/CommonName  Yes Yes .
| Attribute Stores AD FS 1x E-Mail Address http://schemas xmisoap org/claims/EmailAddress  Yes Yes [6] Refresh
Group hitp://schemas xmlsoap .org/claims/Group Yes Yes ﬂ Help
AD FS 1x UPN http://schemas xmlsoap .org/claims/UPN Yes Yes
Role http://schemas microsoft. com/ws/2008/06/iden...  Yes Yes
Sumame http://schemas xmlisoap .org/ws/2005/05/identit... Yes Yes
PPID http://schemas xmisoap.org/ws/2005/05/identit Yes Yes
Name ID http://schemas xmlsoap .org/ws/2005/05/identit... Yes Yes
Authentication time stamp http://schemas microsoft com/ws/2008/06/iden... Yes Yes
Authentication method http://schemas microsoft. com/ws/2008/06/iden...  Yes Yes
Deny only group SID hitp://schemas xmlsoap .org/ws/2005/05/identit... Yes Yes
Deny only primary SID http://schemas microsoft. com/ws/2008/06/iden...  Yes Yes
Deny only primary group SID  http://schemas microsoft.com/ws/2008/06/iden... Yes Yes
Group SID http://schemas microsoft com/ws/2008/06/iden... Yes Yes
Primary group SID http://schemas microsoft.com/ws/2008/06/iden... Yes Yes
Primary SID http://schemas microsoft.com/ws/2008/06/iden... Yes Yes
Windows account name http://schemas microsoft.com/ws/2008/06/iden... Yes Yes
\ \ \

3. Klik in de rechterkolom onder 'Actions' op Add Claim Description....

Add a Claim Description E3
You can add a claim description to identify and describe this claim for later use

Display name:
Ium:mace:dir:amibutedef:uid

Claim identifier:
Jummace dir attribute-def uid|
Example: http://schemas xmlsoap .org/ws/2005/05/identity/claims/emailaddress

Description:

u Publish this claim description in federati data as a claim type that this Federation
Service can accept

u Publish this claim description in federation data as a claim type that this Federation
Service can send

oK | cCanced | Hep |

4. Vul in de velden 'Display name' en 'Claim identifier' de waarde in van het attribuut
dat u wilt vrijgeven aan de SURFfederatie. Zie voor een overzicht van attributen:
http://www.surffederatie.nl/attributenschema.

@ Vul voor elk attribuut in beide velden exact hetzelfde in.

5. Klik op OK.
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6. Herhaal de voorgaande stap voor alle attributen, zodat deze onderaan in de lijst van
Claim Descriptions verschijnen.

@ Het attribuut ‘Name ID’ hoeft niet te worden gedefinieerd, omdat dit attribuut al

bestaat.
s
i Fle Acton View Window Help ‘ =8 x|
AN 7]
_| ADFS 2.0 Claim Descriptions Actions
B SEjVE';Edpoin‘s Name Claim Type Published ... [ Publis | Claim Descriptions &
| Certificates E-Mail Address http://schemas xmisoap .org/ws/2005/05/identit... Yes Yes Add Claim Description...
| Claim Descriptions Given Name http://schemas xmisoap .org/ws/2005/05/identit... Yes Yes
= [ Trust Relationships Name http://schemas xmisoap .org/ws/2005/05/identit... Yes Yes View 4
| Claims Provider Trusts UPN http://schemas xmlsoap.org/ws/2005/05/identit... Yes Yes New Window from Here
| Relying Party Trusts Common Name http://schemas xmlsoap .org/claims/CommonName ~ Yes Yes —
| Attribute Stores AD FS 1x E-Mail Address http://schemas xmlsoap .org/claims/EmailAddress ~ Yes Yes G Refresh
Group http://schemas xmlsoap .org/claims/Group Yes Yes ﬂ Help
AD FS 1x UPN http://schemas xmlsoap .org/claims/UPN Yes Yes Z
Role hitp://schemas microsot.com/ws/2008/06/den... Yes Yoo |[emecsimatinbutedch
Sumame http://schemas xmlsoap.org/ws/2005/05/identit... Yes Yes Properties
PPID http://schemas xmlsoap.org/ws/2005/05/identit... Yes Yes x Delete
Name ID http://schemas xmlsoap .org/ws/2005/05/identit... Yes Yes
Authentication time stamp http://schemas microsoft.com/ws/2008/06/iden... Yes Yes ﬂ Help
Authentication method http://schemas microsoft.com/ws/2008/06/iden...  Yes Yes
Deny only group SID http://schemas xmlsoap.org/ws/2005/05/identit Yes Yes
Deny only primary SID http://schemas microsoft.com/ws/2008/06/iden...  Yes Yes
Deny only primary group SID http://schemas microsoft.com/ws/2008/06/iden... Yes Yes
Group SID http://schemas microsoft.com/ws/2008/06/iden... Yes Yes
Primary group SID http://schemas microsoft.com/ws/2008/06/iden... Yes Yes
Primary SID http://schemas microsoft.com/ws/2008/06/iden... Yes Yes
Windows account name http://schemas microsoft.com/ws/2008/06/iden... Yes Yes
um:mace dir:attribute-def uid um:mace dir:attribute-def uid No No
um:mac ribute-d i um:mace: ribute-def mai No No

< i b
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5.3 Attributen toewijzen aan SURFfederatie

1. Kies in de linkerkolom Trust Relationships > Relying Party Trusts.

_| Claims Provider Trusts
| Relying Party Trusts
| Attribute Stores

ij= 3
i File Acon View Window Help | =181
7l
7 ADFS 2.0 [T — —
= (] Service .
Endponts Reling Party Trusts «
| Certificates SURFederatie Yes wayf surfnet.nl Add Relying Party Trust...
Claim Descriptions SURFfederatie (TEST) Yes wayftest.surfnet nl =
1 View
[ [] Trust Relationships iew

New Window from Here

|G Refresh

ﬂ Help

SURFfederatie -
Update from Federation ...
Edit Claim Rules...
Disable
Properties

x Delete

ﬂ Help

\Edit claim rules for the selected relying party trust

2. Klik in de middelste kolom op SURFfederatie (TEST), en vervolgens in de
rechterkolom op Edit Claim Rules.

" Edit Claim Rules for SURFfederatie
Issuance Transfomm Rules I Issuance Authorization Rules | Delegation Authorization Rules |
The following transform rules specify the claims that will be sent to the relying party.
Order | Rule Name I Issued Claims |
Add Rule... Remove Rule... |
0K | Concel | oy Help
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3. Klik op Add Rule....

'*‘} Add Transform Claim Rule Wizard B3

Select Rule Template

Steps Select the template for the claim rule that you want to create from the following list. The description
@ Choose Rule Type provides details about each claim rule template.
@ Configure Claim Rule Claim rule template:

Send LDAP Attributes as Claims _'J

Claim rule template description:

Using the Send LDAP Attribute as Claims rule template you can select attributes from an LDAP attribute
store such as Active Directory to send as claims to the relying party. Multiple attributes may be sent as
muttiple claims from a single rule using this rule type. For example, you can use this rule template to
create a rule that will extract attibute values for authenticated users from the displayName and
telephoneNumber Active Directory attributes and then send those values as two different outgoing
claims. This rule may also be used to send all of the user’s group memberships. If you want to only send
individual group memberships, use the Send Group Membership as a Claim rule I

Tell me more about this rule template....

Previous l Next > Cancel | Help |

4. Kies onder 'Claim rule template' voor Send LDAP Attributes as Claims klik op Next.

'*‘} Add Transform Claim Rule Wizard B3

Configure Rule

Steps You can configure this rule to send the values of LDAP attributes as claims. Select an attribute store from
@ Choose Rule Type which to extract LDAP attributes. Specify how the attributes will map to the outgoing claim types that will be
issued from the rule.
@ Configure Claim Rule
Claim rule name:

|eduPerson LDAP

Rule template: Send LDAP Attributes as Claims

Attribute store:
Active Directory l]

Mapping of LDAP attributes to outgoing claim types:

LDAP Attribute Outgoing Claim Type
User-Principal-Name j Name ID
SAM-Account-Name
E-Mail-Addresses

um:mace dir:attribute-def uid

v
v

um:mace dir:attribute-def:mail

L

*
Lo
I

> Display-Name

Ll fl e ) e

< Previous l Finish I Cancel | Help |

5. Vul een zinvolle naam in in het veld 'Claim rule name', bijvoorbeeld 'eduPerson LDAP'.

6. Selecteer onder 'Attribute store' de optie Active Directory.
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7. Voeg de volgende attribuutmappings toe:

LDAP Attribute

Outgoing Claim Type

User Principal Name

Name ID

SAM-Account-Name

urn:mace:dir:attribute-def:uid

E-Mail-Addresses

urn:mace:dir:attribute-def: mail

Display-Name

urn:mace:dir:attribute-def:displayName

8. Klik op Finish.

"% Edit Claim Rules for SURFfederatie (O]

Issuance Transfom Rules | Issuance Authorization Rules | Delegation Authorization Rules |

The following transform rules specify the claims that will be sent to the relying party.

Order | Rule Name Issued Claims

eduPerson LDAP Name |D um:mace dir:attr...

ESE

Add Rule... Edit Rule... l Remove Rule... |

ok | cance | Appy Help

9. Klik op OK.

5.4 Testen

U kunt testen of de vrijgave van de attributen is gelukt.

1. Ga naar https://wayf-test.surfnet.nl/attributes.

2. Selecteer uw instelling en log in.

U ziet nu een overzicht van de attributen die worden vrijgegeven aan uw instelling.
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